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Information in this document is subject to change without notice. Spartan Bioscience assumes no responsibility for any errors that may appear 
in this document. This document is believed to be complete and accurate at the time of publication. In no event shall Spartan Bioscience be 
liable for incidental, special, multiple, or consequential damages in connection with or arising from the use of this document.

Research Use Only 

This instrument is for research use only and is not intended for clinical or diagnostic applications.

PCR and real-time PCR processes are covered by patents issued and applicable in certain countries. Spartan does not encourage or support the 
unauthorized or unlicensed use of PCR or real-time PCR processes. Use of this instrument is recommended for persons that either have licenses 
to perform PCR and real-time PCR or are not required to obtain licenses. 

Patents Pending 

The Spartan DX-12™ is protected by patents pending in multiple geographic areas. 

Trademarks 

Spartan DX-12™ is a registered trademark of Spartan Bioscience Inc.  All other trademarks are the sole property of their respective owners.
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Intended Use

The Spartan DX-12™ is designed to analyze purifi ed nucleic acids using nucleic acid amplifi cation techniques 
such as Polymerase Chain Reaction (PCR).

The Spartan DX-12™ is for research use only and is not intended for clinical or diagnostic applications.

Contact Information

The Spartan DX-12™ was developed and is manufactured by:

Spartan Bioscience Inc.
203-15 Grenfell Crescent
Ottawa, ON K2G 0G3
www.spartanbio.com

For more information: info@spartanbio.com
For technical support: support@spartanbio.com

Warranty 

The Spartan DX-12™ is warranted to meet or exceed the stated specifi cations. Spartan’s sole obligation and the 
customer’s sole remedy is limited to replacement of instruments free of charge in the event the instrument fails to 
perform as warranted. Spartan makes no other warranty of any kind whatsoever, and SPECIFICALLY DISCLAIMS 
AND EXCLUDES ALL OTHER WARRANTIES OF ANY KIND OR NATURE WHATSOEVER, DIRECTLY OR INDIRECTLY, 
EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, AS TO THE SUITABILITY, PRODUCTIVITY, DURABILITY, 
FITNESS FOR A PARTICULAR PURPOSE OR USE, MERCHANTABILITY, CONDITION, OR ANY OTHER MATTER WITH 
RESPECT TO SPARTAN PRODUCTS. In no event shall Spartan be liable for claims for any other damages, whether 
direct, incidental, foreseeable, consequential, or special (including but not limited to loss of use, revenue or profi t), 
whether based upon warranty, contract, tort (including negligence) or strict liability arising in connection with the 
sale or the failure of Spartan instruments to perform in accordance with the stated specifi cations. 

Visit www.spartanbio.com/products/warranty_service/ for complete Warranty details and Extended Warranty   
information.

 

General InformationGeneral Information
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Box ContentsBox Contents

1 Spartan USB Drive Containing 
All Supporting Materials

(Cat. No. 01004429)

1 Spartan DX-12 
(Cat. No. 01004350)

12 Centrifuge Adaptors
(Cat. No. 01004247)

1 Setup Rack
(Cat. No. 01004357)

A Starter Pack of Spartan Tubes and Lids
(20µl PCR Tube Assembly, Tubes - Cat. No. 

01004153 and Caps - Cat. No. 01004155) 

12V Power Supply and Power Cord (Cat. No. 01004381)

Unpacking and Installation Instructions (Cat. No. 01001084)

DX-12 DNA Analyzer User Manual (Cat. No. 01001056)

Spartan DX-12 Quick Reference Guide (Cat. No. 01001057)

Spartan Analyzer Software User Manual (Cat. No. 01001044)

Release Notes (Cat. No. 01001058)
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Unpacking

The Spartan DX-12™ is shipped in a cardboard container with molded inserts. The container should be carefully 
inspected for damage.  Report any damage to your authorized Spartan Bioscience dealer before accepting the 
unit.  We recomend you read the unpacking and setup instructions.

The instrument measures 17cm (W) x 36cm (L) x 12cm (H) and weighs 4.2 kg. It is easily handled by one person.

Instrument Contents

Spartan DX-12™ Desktop DNA Analyzer (Cat. No. 01004350)

12V Power Supply and Power Cord (Cat. No. 01004381)

USB Drive Containing All Supporting Materials (Cat. No. 01004429)

12 Centrifuge Adaptors (Cat. No. 01004247)

1 Set-up rack (Cat. No. 01004357)

Starter Pack of Spartan tubes (20µl PCR Tube Assembly, Tubes - Cat. No. 01004153 and Caps - Cat. No. 
01004155).

 The Spartan DX-12™ should be used with manufacturer-supplied accessories only.

Operating Requirements

This instrument is designed for indoor use only.

Operate in ambient temperature between 15 and 25°C (59 and 77°F).

Do not operate in a cold room or a refrigerated area.

Operate in ambient relative humidity of 20 to 50%.

These specifi cations have been calculated for altitudes between 0 and 2,000 meters.

Ensure adequate front and rear ventilation.

Installation 

1. Unpack and position the instrument on the workbench in the upright position. Allow 30 cm space in 
front and behind the instrument to ensure suffi cient cooling of the electronic components.

   Failure to provide ventilation space may impact the instrument’s ability to maintain proper operating 
temperatures.  This could negatively impact your reaction results and cause the instrument to overheat. 

2. Store original packaging in a safe location in case, at any time, the instrument should require 
shipping.

3. Select a site for the instrument where:

• Ambient temperature is maintained at 15 to 25°C. Avoid direct exposure to air conditioning, heating 
vents, and direct sunlight.

• Relative humidity is 20 to 50%, non-condensing.

• Exposure to dust and drafts is minimal.

• There is minimal vibration to the instrument.

• An electrical outlet is available. The power supply automatically accommodates incoming voltages 
between 100-240 V AC and 50-60 HZ. Use of an un-interruptible power supply (UPS) is recommended.

4. Plug the power supply into the instrument and connect the power supply to power source.

5. The instrument is now operational.

Instrument InstallationInstrument Installation
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6.  Upon initial instrument running, we recommend you insert 12 empty tubes into the instrument, mount 
the provided UBS stick, navigate to the Options menu and initiate a report.  This should take 10-15 
minutes to run. DO NOT remove the USB stick during this process. Once it has been completed, please 
forward the results (3 fi les) to support@spartanbio.com so that we may verify the functionality of the 
unit.

To set date/time:

1. The fi rst time the instrument is started, you will be prompted to set the date and time.

2. Move to the appropriate “Set Date/Time” fi eld using the outside buttons and select using the center 
button.

3. Modify the fi elds using outside buttons and unselect by pressing center button.

4. Select “Save” using the center buttom to save your new date and time settings.

Instrument Installation (continued)Instrument Installation (continued)

Power Connector

Center Keypad Button

Outside Keypad Button

USB Slot

Flash Card Slot

LCD Display
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System Requirements

Hardware

800 MHz  x86 processor or higher

1024 x 768 display or higher

512 Meg of RAM minimum

OS and Software

Windows XP or higher

Software Installation

Spartan Graphing & Analysis software can be found on the USB memory key included with the Spartan DX-12TM 
instrument. To install the software, insert the USB key into your computer and run the installation program. The 
Spartan Graphing & Analysis Setup Wizard will guide you through the steps required to install Spartan Graphing 
& Analysis software on your computer. Note that use of the software is intended for persons that either have 
licenses to perform PCR and real-time PCR, or are not required to obtain licenses. You must agree to the License 
Agreement in order to complete the installation.

To uninstall Spartan Graphing & Analysis software, run the installation program and select Remove Spartan 
Graphing & Analysis. Upgraded versions of software can be installed without the need to uninstall previous 
versions.

Support

For more information or help with Spartan Graphing & Analysis software, contact Spartan Bioscience by e-mail 
at support@spartanbio.com.

Spartan Graphing & Analysis Software InstallationSpartan Graphing & Analysis Software Installation

About Spartan Graphing & Analysis SoftwareAbout Spartan Graphing & Analysis Software

Spartan Graphing & Analysis software is a full-featured analysis package for data produced by the Spartan DX-12TM 
instrument. The Spartan DX-12TM instrument produces run data in the form of data fi les, which are transferred 
between the device and a PC by USB memory key, or SD card. Spartan Graphing & Analysis software automatically 
analyzes data from imported data fi les, displays results in convenient graphical form, and provides the option to 
adjust analysis settings to your preferences. The software is organized into three tabs: Run Data tab, Quantifi cation 
tab, and Melt Curve tab. 

Note - The default display in Spartan Graphing & Analysis software is the Run Data tab. The view can be toggled 
between the three tabs (Run Data, Quantifi cation, Melting Curve) by clicking with the mouse on the appropriate 
tab name (Figure 1). 
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Shows information
related to the 

imported run data
(see Section 3.5)

Select tabs to switch
between displays

(see Section 2)

Allows you to enter 
details of the run,

including sample type
and name, and

define your graphing 
colour preferences 
(see Sections 4.3,

4.4, 4.6)

Use this section to 
enter your own notes
associated with the 
run

Graphical display of 
run information. The
graph shown will
depend on the
selected tab in view
(Run Data,
Quantification,
Melting Curve)

(a)  (b) (c)                   (d)  (e)  (f)   (g)    (h)      (i)   (j)   (k)  (l)    See Section 2.4 for
description of toolbar
menu options

Figure 1. Default window display (Run Data tab) in Graphing & Analysis software.

There are two ways to load data into Spartan Graphing & Analysis software:

A) “Import” (Importing Data) - this option is used to load raw data generated from a run on the 
Spartan-DX-12 instrument into the graphing software. Files generated by the Spartan DX-12 
have the extension .txt. Once a .txt fi le has been imported into Spartan Graphing & Analysis 
software, the data can be saved as a .sdx fi le. 

B) “Open” (Opening a .sdx fi le) - this option is used to open a previously saved Spartan Graphing & 
Analysis fi le with the.sdx extension. Files with the extension .sdx can be reopened from within 
the software or can be opened directly, i.e. double-clicking on the fi le will launch the software 
and display the related data

Importing Data

Results of Spartan DX-12 runs are saved on the Flash card or USB drive as non-editable encrypted data 
fi les, with the naming convention:  AAAAAAA_UUUUU_DDMM_RR.txt (where: AAAAAAA is the name 
of the program ran on the Spartan DX-12; UUUUU is the Spartan-DX-12 instrument number (can be 
found on the instrument welcome screen); DDMM is the day and month; RR is the run number of the 
day). Files are saved to the following location on the Flash card or USB drive:

/rundata/UUUUU/DDMM_RR

UUUU is the unit ID number, DDMM are day and month, and RR is run of the day). Encrypted data fi les 
can only be opened in Spartan Graphing & Analysis software. To import data into the software, use one 
of the following options:

A) Select File then Import from the toolbar menu

B) Click on the Import icon  on the toolbar

C) Use the Hotkey <Ctrl + I>

The Import dialogue window will open (Figure 2). Navigate to the location of the saved data fi le and 
select Open. The data should now be loaded into the Spartan Graphing & Analysis software. The display 
will default to the Run Data tab (Figure 1).

About Spartan Graphing & Analysis Software (continued)About Spartan Graphing & Analysis Software (continued)



-7-

Spartan Bioscience Inc. | 203–15 Grenfell Crescent | Ottawa, ON Canada K2G 0G3 | Tel +1[877] 228–7756 | SpartanBio.com

© 2009 Spartan Bioscience Inc.

About Spartan Graphing & Analysis Software (continued)About Spartan Graphing & Analysis Software (continued)

Figure 2. Import Data File dialogue window

Saving Data

Data imported into the software from a data fi le can be saved as a Spartan Graphing & Analysis fi le 
(.sdx extension), which can be reopened directly in the software. To save data as a .sdx fi le, use one of 
the following options:

A) Select File then Save from the toolbar menu

B) Click on the Save icon  on the toolbar

C) Use the Hotkey <Ctrl + S>

Once the data is saved as a .sdx data fi le, the name of the fi le will appear in the program title bar with 
the .sdx extension (Figure 3).

Opening an .sdx File

To open a previously saved .sdx fi le in Spartan Graphing & Analysis software, use one of the following 
options:

A) Select File then Open from the toolbar menu

B) Click on the Open icon  on the toolbar

C) Use the Hotkey <Ctrl + O>
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End-Point/Real Time and Melt Curve Operational Modes

The Spartan DX-12™ is shipped in “End-Point” operational mode. In order to operate the unit in “Real Time” or 
“Melt Curve” modes, these functions must be activated.  

To activate “Real Time” or “Melt Curve” modes:

1. Using the keypad, select the “Options” menu on the instrument.

2.  Move to “System Settings” using the outside buttons and select using the center button.

3. Once within the “Sytem Settings” menu, “Melt Curve” or “Real Time” modes can be turned Off/On 
by moving to and selecting the appropriate fi eld using the outside buttons and the center button, 
then toggling up and down with the outside arrow keys, pressing the center ket again to register you 
selection.

N.B.: The fi rst time you change the “Real Time” or “Melt Curve” operational setting, you will be 
prompted to “AGREE” or “DISAGREE” to a disclaimer.  If you do not “AGREE” to the disclaimer, 
the “Real Time” or “Melt Curve” modes will remain “OFF”, and will be inacessible.  Only once the 
disclaimers are “AGREED“ to can you access these operational modes.

Reaction Set-up 

A. Thermal cycling 

The Spartan DX-12™ is designed to run two- or three-temperature thermal cycling programs. A  three-temperature 
program has three steps: denaturation, annealing, and extension. A two-temperature program combines the 
annealing and extension steps into a single step. Although three-temperature programs are more traditional, two-
temperature programs usually provide the same performance while signifi cantly shortening run times. 

Isothermal programs may also be performed on the Spartan DX-12™ by setting the denaturation, annealing, and 
extension steps to the same temperature.

Note that the dwell time at each temperature begins once the reaction tube reaches the specifi ed temperature. 
For example, if the denaturation temperature is set at 95°C, and the denaturation dwell time is set at 10 s, the 
10 s countdown begins once the reaction tube reaches of 95°C. For most applications, only a few seconds of 
denaturation time are suffi cient to denature the amplicon during thermal cycling.

Designing a Program

Each gene target is unique and may require optimization of the cycling program. Here are some general guidelines 
for determining the appropriate temperatures and dwell times for your program:

1. Design primers with matching melting temperatures (Tm), preferably between 60-68°C, and amplicon 
size of < 300 base pairs (bp). For faster cycling speeds, the primers should have Tms of 65-68°C, and 
amplicon size of < 150 bp.

2. Set the annealing temperature to the calculated Tm.

3. For three-temperature programs, set the extension temperature to  72°C for 10 s. For two-temperature 
programs, the extension temperature is combined with the annealing temperature and no separate 
extension time is used.

4. Set the annealing and/or extension time to 30 seconds.

5. For denaturation temperatures and times, we recomend starting with the following settings:

DNA Source Denaturation Temp Initial Time Cycling Time

Human/Mammalian 95°C 2.5 min 10 s

Bacterial/Viral 95°C 1 min 10 s

Operating InstructionsOperating Instructions
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B. Detection chemistries 

The Spartan DX-12™ is a 2-channel instrument. The fi rst channel detects green wavelengths (520-532 nm), and 
the second channel detects red wavelengths (620-800 nm). The detection system is compatible with standard 
probe chemistries such as TaqMan® probes, Scorpion probes and molecular beacons. It is also compatible with 
DNA intercalating dyes such as SYBR Green (Life Technologies). For probe technologies, Spartan recommends the 
use of non-fl uorescent quenchers such as BHQ-1 and BHQ-2 (Black Hole Quencher®, Biosearch Technologies). For 
further details, see Spartan Application Notes 005 and 012 at http://www.spartanbio.com/support/application-
notes/.  

For SYBR Green I dye (Invitrogen, Cat. No. S7563), we recommend a concentration of 0.4X. However concentrations 
in the range of 0.2-1.0X are acceptable. For further details, see Spartan Application Note 0XX at http://www.
spartanbio.com/support/application-notes/.

 C. Reaction tubes 

The Spartan DX-12™ is designed to work with Spartan reaction tubes (20µl PCR Tube Assembly, Tubes - Cat. No. 
01004153 and Caps - Cat. No. 01004155). These tubes have been optimized for fast heating and cooling kinetics, 
and must be used to perform PCR on the Spartan DX-12..

Spartan reaction tubes are designed to be loaded directly with a pipette tip.. To load tubes, insert loaded pipette 
tip to the bottom of the tube, and slowly release the liquid while raising the pipette, ensuring the tip of the 
pipette is kept at the surface of the liquid..  This should release the liquid evenly into the tube without creating 
any bubbles.

Operating Instructions (continued)Operating Instructions (continued)

Run ProgramRun Program

A. Warming Up and Turning Off

1. Plug in the Spartan DX-12TM.

2. There is no power switch on the Spartan DX-12TM. Turn on the instrument by pressing any key on the 
keypad.

3. Once the instrument is turned on, and you enter into the setup window, it will take about 10 minutes to 
warm up and equilibrate to room temperature.

D. Reaction volumes 

Spartan reaction tubes have a maximum void volume of 25 µl. The minimum reaction volume is 10 µl. Spartan 
recommends standard reaction volumes of 10-20 µl.
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4. To manually turn off the instrument, select “Off” from the Main Menu. When the instrument is turned 
“Off” all features of the instrument including fans and heaters are turned off.  However, the instrument 
is effectively in “sleep mode” and can be turned back on by pressing any button.

5. After 30 min of inactivity, the display screen will turn off. After a default time of 4 hours of inactivity, the 
instrument will turn “Off”.  This auto-shut off time can be changed through the “Options” menu, under 
“System settings” 

6. To ensure that there is no power going to the instrument, unplug the power cord.

B. Selecting a Program

1. Use the left and right outside keypad buttons on the keypad to move to the “File” menu. Press the center 
button to select this menu.

2. To create a New Program, use the outside keypad buttons to navigate down to the “New” menu and 
select it. In the program setup screen, edit the name of your new program by pressing the center button. 
Use the up and down outside keypad buttons to adjust the characters, and use the left and right outside 
keypad buttons to move from one character to the next. When you are fi nished, press the center keypad 
button to accept the new program name.

3. To open an Existing Program, use the outside keypad buttons to navigate down to the “Open” menu and 
select it. Use the up and down arrows to move between programs in the program list. Programs will be 
displayed in numeric, then alphabetical order. Select a program by pressing the center button. Open the 
program by selecting “Open” from the options on the bottom of the screen. At any time, you may select 
a program using the center button, and use the outside keypad buttons to move between the “Open”, 
“Delete”, and “Cancel” options at the bottom of the screen.

C. Setting Up a Program

1. After you have created a New Program, or have opened an Existing Program, the Program Setup Screen 
allows you to specify settings for the Reverse Transcription, Thermal Cycling, and Melt Curve steps in your 
program. 

2. Use the outside keypad buttons to navigate between the program steps. Select “On” or “Off” to toggle 
the appropriate steps. Note that the instrument will perform the steps in the following order: Reverse 
Transcription → Thermal Cycling → Melt Curve. Steps set to “Off” will not be performed.

3. To save modifi cations to your program, select the “Save” option at the bottom of the screen. If you 
modify any of the three components of a program and run it without saving, the program will run as 
entered, but the the changes will be lost at the end of the run.

Proper Tube Orientation

Run Program (continued)Run Program (continued)
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Run Program (continued)Run Program (continued)

4. Alternately a PCR program can be created on a PC (See the Spartan DX-12 User’s Manual for instructions 
on “Editing Standard Process Files from your PC”)

 For more involved programs, see the Spartan DX-12 Operator’s Manual for instructions on 
how to setup and run “Custom Process Files”.

Reverse Transcription

1. To modify the Reverse Transcription temperatures and dwell times, use the outside keypad buttons to 
navigate to “Reverse Transcription” and select it using the center button.

2. In the Reverse Transcription Setup Screen, use the outside keypad buttons to navigate between the 
temperatures and dwell times. After using the center button to select a setting to change, use the up and 
down outside keypad buttons to change the values. Use the center button to accept the new entry.

3. Step #1 specifi es the Reverse Transcription synthesis conditions, and Step #2 specifi es the Reverse 
Transcription denaturation conditions.  Step #2 of the Reverse Transcription program, and Step #0 of the 
Thermal Cycling program are performed sequentially when both programs are selected.  This should be 
kept in mind when setting up a program that involves a Reverse Transcription step.

4. When you are fi nished adjusting the values, navigate to the bottom of the screen and select “Ok”.

5. To cancel your modifi cations, navigate to the bottom of the screen and select “Cancel”.

Thermal Cycling

1. To modify the Thermal Cycling temperatures and dwell times, use the outside keypad buttons to navigate 
to “Thermal Cycling” and select it using the center button.

2. In the Thermal Cycling Setup Screen, use the outside keypad buttons to navigate between the temperatures, 
dwell times, and cycle number. After selecting a setting to change, use the up and down outside keypad 
buttons to change the values. Use the center button to accept the new entry.

3. Step #0 specifi es the initial denaturation conditions. During the cycling phase of the program, Steps #1, 
2, and 3 specify the denaturation, annealing, and extension conditions, respectively. 

4. When you are fi nished adjusting the values, navigate to the bottom of the screen and select “Ok” by 
pressing the center button.

5. To cancel your modifi cations, navigate to the bottom of the screen and select “Cancel”.

6. By default Thermal Cycling is set to “3-Temp” thermal cycling conditions. To switch between two-
temperature and three-temperature programs, toggle the “2-Temp” or “3-Temp” option at the bottom of 
the screen by selecting it with the center button.

Melt Curve

1. To modify the Melt Curve temperatures and dwell times, use the outside keypad buttons to navigate to 
“Melt Curve” and select it using the center button.

2. In the Melt Curve Setup Screen, use the outside keypad buttons to navigate between the temperatures 
and dwell times. After selecting a setting to change, use the up and down outside keypad buttons to 
change the values.

3. Step #1 specifi es the initial denaturation conditions. Step #2 specifi es the starting temperature for the 
melt curve. Step #3 specifi es the end temperature for a single-step melt curve. Step #4 specifi es the 
end temperature for a multi-step melt curve. “°C/step” specifi es the frequency of data acquisition. The 
minimum and maximum increments are 0.1°C/step and 1.0°C/step, respectively.

4. When you are fi nished adjusting the values, navigate to the bottom of the screen and select “Ok”.

5. To cancel your modifi cations, navigate to the bottom of the screen and select “Cancel”.
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Run Program (continued)Run Program (continued)

Flash Card
(2GB or less)

USB Slot

Flash Card Slot

USB Drive

Center Button

Outside Keypad Button

Data AnalysisData Analysis

Thermal Cycling

1. During a Thermal Cycling program, the fl uorescence intensity of each well is measured after the fi rst and 
last cycles. You may change from end-point detection to real-time detection in the “Options” menu by 
turning on “Real-time mode”.  You must agree to the disclaimer before real-time mode will be  turned 
on.

2. At the end of a Thermal Cycling program, you may view the fl uorescence results on the instrument’s LCD 
screen. Fluorescence values are displayed on a scale from 1 to 999. Display value = (fl uorescence last cycle 
- (minimum fl uorescence+1))/2000 (rounded to the nearest whole number) If the result is <01, display 
“00” 

Data AnalysisData Analysis

6. By default, the Melt Curve program is set to “Single-Step”. A Single-Step program uses the same 
temperature increment from the starting to end temperatures. To switch between single-step and multi-
step programs, toggle the “Single-Step” to “Multi-Step” option at the bottom of the screen by selecting 
it. A Multi-Step program allows you to set two different temperature increments between the starting 
and end temperatures. This feature is useful if you want higher resolution for a specifi c region of the 
curve, but want the overall run-time to be short.

D. Running a Program

1. Insert Spartan reaction tubes into the instrument. Ensure that the tubes are properly nested in each well. 
Do not force the tubes down into the wells. Close the instrument lid.

2. From the Program Setup Screen, select the “Run” option from the bottom of the screen.

3. While the program is running, you may increase the cycle number at any time by navigating to the cycle 
number denominator on the screen with the outside keypad, puching the center button to select it, and 
the up and down arrow key to make the changes, pressing the center button again to implement the 
changes.

4. While the program is running, you may also select “Stop” at any time. Note that the program is only 
stopped after you select “Yes” to confi rm stopping the program. When a program is stopped, all data 
accumulated to that point has been saved and is available via the “Save Last Run” feature in the “Options” 
menu.  If a Flash Card (2 GB or less), or USB drive is present in the unit during the run, the data will also 
be automatically written to the drive(s).
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3. When in “Real-Time” mode, data aquisition occurs following the Annealing/Extension step (Step 2) during 
2-Temperature PCR, and following the Extension step (Step 3), during 3-Temperature PCR.

4. Selecting “Save” at the bottom of the screen saves the results to either the Flash card (2GB or less) or the 
USB drives. 

5. To graph the results, remove the Flash card or USB drive from the instrument and insert it into the 
corresponding port of a personal computer (PC).

6. Data is stored as a “.txt” fi le on the Flash card or USB drive. The fi le will be saved with the following 
naming convention: AAAAAAA_UUUU_DDMM_RR.txt, where AAAAAA is the program name, UUUU is 
the unit ID number, DDMM are day and month, and RR is run of the day.  This data is encrypted and can 
only be graphed using Spartan Analyzer software that is supplied with the instrument.

 N.B.: This data can ONLY be graphed using Spartan Analyzer software that is supplied with 
the instrument.

7. The User Manual for the Spartan Analyzer software is available for download at: http://www.spartanbio.
com/products/manuals/

Melt Curve

1. During a Melt Curve program, the fl uorescence intensity of each well is measured after each temperature 
increment.

2. At the end of a Melt Curve program, select “Save” at the bottom of the screen to save the results to both 
the Flash card and USB drives in the instrument. 

3. To graph the results, remove the Flash card or USB drive from the instrument, and insert it into the  
corresponding port of a PC.

4. Melt curve data is stored in the same fi le as the Themal Cycling data. This data may also be graphed using 
Spartan Analyzer software.

5. The User Manual for the Spartan Analyzer software is available for download at: http://www.spartanbio.
com/products/ spartan-dx-12/manuals/

Data Analysis (continued)Data Analysis (continued)

In the “Options” menu, there are various optional settings and features:

1. Move to the appropriate “Set Date/Time” fi eld using outside buttons and select using center button.
Modify the fi elds using outside buttons and unselect by pressing center button. Select “Save” to save 
your new date and time settings. Note that it is important to set the correct date and time because a 
date-and-time stamp is saved with the fl uorescence results for each run.

2. To re-save the results from the previous run, select “Save Last Run”. Note that the instrument will only 
store data from the most recent run and that these results will be over-written with every additional 
run.

3. To troubleshoot any problems you may experience with the instrument, select “Reports”. This will save an 
instrument status report to the Flash card and USB drives. The self tests will take 10-20 minutes for the 
instrument to perform.  The resulting report can be e-mailed to Spartan Bioscience for trouble-shooting 
or verifi cation purposes..

4. Some DNA amplifi cation assays for the Spartan DX-12TM come with pre-defi ned programs. These programs 
may be up-loaded to the instrument by saving them to Flash Card or USB under a folder named “process” 
and ensuring that they have a 7-digit name.  These pre-defi ned programs can then be loaded onto the 
instrument by inserting the Flash Card or USB in to the instrument and selecting “Load Process File”, 
choosing the appropriate program, and selecting transfer. Loading a process fi le with the same name 

Data Analysis (continued)Data Analysis (continued)Data Analysis (continued)Data Analysis (continued)
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as an existing one will overwrite the pre-existing fi le. Note that custom process fi les cannot be edited 
through the “Open” menu.

5. In the “System Settings” menu, you have the option of turning “On” or “Off” the “Real-Time Mode” 
and “Melt Curve Mode” features. You may also specify the duration of time before the instrument 
automatically shuts off after a period of inactivity.

Optional Settings (continued)Optional Settings (continued)


